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ABSTRACT: The study of traditional residential courtyards promotes the protection and renovation of traditional residences and enriches the spatial
expression of new residential courtyards. As an organic component of the traditional residence, the courtyard space plays a role in improving, ampli-
fying, and complementing the function of the main building space. This study investigated 63 Huizhou traditional residential courtyards, including
those in Xidi, Hongcun, Nanping and Pingshan. The basic architectural information was first examined, and a field survey was undertaken to dis-
close the relationship between the courtyard and the main building space. The morphological characteristics of the courtyard were described through
five dimensions: area, area ratio, aspect ratio, saturation, and boundary coefficient. Then, the courtyard space was classified through clustering anal-
ysis. Meanwhile, the courtyards’ location and characteristics of elemental organization within different morphological types were considered.

The study shows that the traditional Huizhou courtyards can be classified into four types based on the quantitative clustering characteristics of
spatial morphology, namely: medium-scale square, medium-scale strip, medium-scale irregular, and large-scale complex. Firstly, medium-scale
square courtyards are the most common type, sharing the same proportion and form as the main building space. This type of courtyard offers a sense
of stability and regularity. Moreover, they are typically located in the front and back of the residence. They include stone benches and other elements
arranged with greenery, water, arches, secondary contours, and other elements, enriching the landscape levels and expanding the spatial function.
Secondly, medium-scale strip courtyards mostly appear in large residential groups, which organize people’s routes, depicting the spatial dynamism
and directions. They mainly incorporate structures and arches, sometimes combined with greenery, plaques, stone tables, and openwork windows.
Such structures weaken the sense of enclosure and insecurity generated by the long and narrow space. Thirdly, medium-scale irregular courtyards
present irregular spatial forms in the front and side of the residence due to irregular land conditions and regular main building plans, often serving
as a highlight of the residential space. The configuration of greenery, water, openwork windows, and their mutual combinations is mainly used to
weaken the irregularity of space through spatial remediation and the creation of a visual focus. Finally, large-scale complex courtyards are predomi-
nantly located in backyards and serve as recreational areas and living spaces, enabling people to get close to nature. The configuration of spatial fac-
tors is mainly composed of natural leisure elements, such as water and stone benches. Larger-scale courtyards usually combine with greenery ele-
ments to provide the house owner with a comfortable and private living scene.

The current study clarified the typological characteristics of courtyard spatial forms through clustering analysis. It also discussed the spatial

form and element organization of the traditional Huizhou courtyard. On this basis, the relationships among the courtyard, the building’s main body,
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and the composition and organization of environmental elements were investigated and classified. The research conclusions can provide a theoretical

basis for maintaining traditional residential courtyard forms and preserving their authenticity, as well as a reference for creating new residential

courtyard spaces in Huizhou.

KEYWORDS: Huizhou traditional residence; courtyard; clustering analysis; morphological quantification; elements

Introduction

As an organic component of Huizhou traditional resi-
dences [ 1], the courtyard space is characterized by being
“formed based on the site, adapted to the context, and fol-
lowing principles without fixed modes [2]”, conveying
the cultural characteristics of “farming-reading” and the
integration of Confucian scholarship and commerce. It re-
flects the purpose and belief of life under the Huizhou cul-
tural environment and plays a role in reinforcing, amplif-
ying, and supplementing the function of the main building.
Against the backdrop of changes in traditional social
structure and the rise of village tourism [ 3], traditional
culture and the “spirit of place” are gradually waning, the
spatial pattern of residential courtyards is being destroyed,
and the courtyard landscape is gradually being detached
from traditional society [ 4,5]. In newly constructed resi-
dential courtyards, there are also issues where regional
culture is becoming merely symbolic and superficial [ 6].

In the study of restoring spatial patterns and recon-
structing the cultural connotations of landscapes, research-
ers mostly base their restoration efforts on residents’ oral
accounts, the regional features of courtyards, and the orig-
inal building sites for restoration [ 7]. Previous studies on
courtyard morphology have mostly focused on its relation-
ship with the main building’s orientation, form, and scale.
Courtyard spaces are mostly located in the front, back, and
side of Huizhou traditional residences, with free forms and
variable patterns [ 8]. Studies on the elements of Huizhou
courtyards show that the courtyards are often decorated
with landscape elements such as openwork windows, ar-
ches, rocks, and plants to strengthen the connection be-
tween the courtyard space and the outside world as well as
nature [ 9]. However, the protection and utilization of
courtyard space still reveal problems such as fragmented
theories and insufficient technical methods [ 10]. Based on
the study of regional landscape features, this paper com-

bines morphological research with element organization to
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explore the location and element features of residential
courtyards of different morphological types. This helps to
grasp the internal causes of courtyard space organization,
offers quantitative reference for courtyard space research,
and thereby provides guidance for the restoration and uti-
lization of regional landscape features and cultural conno-
tations in traditional residential space, and enriches the ex-

pression of new residential courtyard space [ 11, 12].

1 Overview of Huizhou traditional residential court-

yards

1.1 Formation background of courtyard spaces

Huizhou villages are situated amidst picturesque
mountains and rivers, with buildings and streets arranged
in a staggered pattern, accompanied by abundant and
beautiful flowers, trees, and vegetation. Influenced by the
architectural philosophy of “suitably selecting the site and
appropriately composing the garden,” Huizhou traditional
residential courtyard spaces have been formed within a
limited space to express an emotional attachment to natu-
ral landscapes. The courtyard space serves not only as a tran-
sition connecting streets with the building interior and an out-
ward extension of the architectural space, but also as an expres-
sion of the owner’s emotions. Influenced by the overall layout
of the village, the direction of the streets and alleys, and the
shape of the houses, the village, within its limited space, ex-
presses the “farming-reading” tradition of scholarly families
and the idealistic pursuit of a “Peach Blossom Spring” (Utopi-
a). Therefore, the study of the typology of Huizhou traditional
residential courtyard spaces is an extension of the study of vil-
lage street space and a refinement of the study of residential
morphology. It also provides theoretical support for under-
standing the relevant aspects of the transition and connection of

village residential clusters.
1.2 Case selection

The study conducted field research in Huizhou tradi-

tional villages such as Xidi, Hongcun, Nanping, and Ping-



SHAO Wei, LI Zao, YE Maosheng/Journal of South Architecture 1:(2026) 45-60

47

shan. These villages are relatively well protected and de-
veloped, and the house layout and configuration of ele-
ments are well preserved [ 13]. The survey mainly focused
on key protected buildings in the village and evaluated the
representativeness of the buildings and courtyard spaces
from the dimensions of their historical significance, integ-
rity, artistry, and authenticity [ 14]. Subsequently, through

on-site measurement and aerial photography, the plans of

63 representative traditional Huizhou residential court-
yards were obtained (Figure 1). Basic information on the
courtyard space was obtained through interviews and liter-
ature reviews (Table 1). Based on the relative relationship
between the courtyard and the main hall’s orientation, the
courtyard space was classified into three categories: front
yard, back yard, and side yard, with 37 front yards, 14
back yards, and 12 side yards.
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Figure 1

1.3 Extraction of spatial elements

The arrangement and combination of courtyard ele-
ments greatly influence the landscape impression of the
courtyard space and further serve as an organic part of
cultural construction. Huizhou Traditional residences typi-
cally have small courtyards, which can create a feeling of
oppression and confinement. The arrangement of spatial
elements plays a role in enhancing the openness and rich-

ness of the courtyard space (Figure 2). Spatial elements are

Selection of sample courtyards

divided into two types: planar elements and vertical ele-
ments. Planar elements mainly include greenery, water,
stone tables, benches, structures, and wells. Among them,
structural elements include porches, bridges, and steps,
which are collectively referred to as structures. Vertical el-
ements include openwork windows, arches, plaques, and
secondary contours. “Secondary contours” refer to tempo-
rary external attachments to the building [ 15], including

lanterns, couplets, signs, and so on. These spatial elements,

http: / www.viserdata.com/journal /jsa



48

SHAO Wei, LI Zao, YE Maosheng/Journal of South Architecture 1:(2026) 45-60

together with the courtyard space, constitute the unique

Huizhou traditional residential courtyard, serving as a

medium for ancient Huizhou literati to express their ideals

and sentiments.

Table 1 Basic information of courtyard spaces
Code Courtyard Name Conservation Era Village Protection Level Current Use
Status

QT10 Yiyuan Garden Excellent Qing Dynasty Residential
QJo3 Xiyuan Garden Excellent Qing (Daoguang) Tourism
QJo4 Zhenshi Xiaozhu Excellent Qing (Daoguang) Residential
CJo3 Taoliyuan Garden Excellent Qing (Xianfeng) Tourism
QJ10 Ruiyu Courtyard Excellent Qing (Xianfeng) Tourism
QJ11 Hu Guoliang Residence Excellent Qing Dynasty Residential
QJ12 Dude Hall Excellent Late Ming National Key Cultural Relics Pro- Guesthouse
QJ13 Hu Jishou Residence (Front Yard) Qing Dynasty Xidi tection Unit (Xidi Ancient Build- | Residential
HJ03 Hu Jishou Residence (Back Yard) Good Qing Dynasty ings) Residential
QJ14 Zhilanpu Good Qing Dynasty Guesthouse
CYO05 Linxi Villa (Side Yard) Excellent Qing (Daoguang) Guesthouse
QTO05 Linxi Villa (Front Yard) Excellent Qing (Daoguang) Guesthouse
QJI5 Binyiju Good Qing Dynasty Guesthouse
QTO06 Yanggao Hall Excellent Ming (Wanli) Guesthouse
QJ16 Qingyunxuan Excellent Qing (Tongzhi) Residential
CYO03 Songhe Hall Excellent Qing (Tongzhi) Guesthouse
QJOS Shuren Hall (Front Yard) Excellent Qing (Tongzhi) Residential
CJo1 Shuren Hall (Side Yard) Excellent Qing (Tongzhi) Residential
QJ17 Taoyuan Residence Excellent Qing (Xianfeng) Tourism
CJo5 Former Residence of Wang Daxie Good Qing (Daoguang) Tourism
QY01 Biyuan Garden Good Late Ming Guesthouse
QTO04 Chengzhi Hall (Front Yard) Excellent Qing (Xianfeng) National Key Cultural Relics Pro- Tourism
CJo4 Chengzhi Hall (Side Garden) Excellent Qing (Xianfeng) Hongcun tection Unit ( Hongcun Ancient | Tourism
CYO01 Chengzhi Hall (Fish Pond Hall) Excellent Qing (Xianfeng) Buildings) Tourism
HTO02 Chengzhi Hall (Back Yard) Excellent Qing (Xianfeng) Tourism
QJ07 Jingxiu Hall Excellent Qing (Daoguang) Tourism
CTO02 Jushan Hall Excellent Qing (Xianfeng) Guesthouse
CJo2 Deyi Hall (East Garden) Excellent Qing (Jiaqing) Residential
QTO03 Deyi Hall (Water Garden) Excellent Qing (Jiaqing) Residential
CY04 Deyi Hall (West Garden) Excellent Qing (Jiaqing) Residential
HJ04 Cunyang Mountain House Excellent Qing (Jiaqing) Tangyue National Key Cultural Relics Protection | Display
QTO8 Xinsuoyu Studio Excellent Qing (Jiaqing) Village Unit (Tangyue Ancient Residences) Display
QJ18 Xu Zhaolai Residence Excellent Qing Dynasty Residential
QJ02 Tongde Hall Excellent Qing Dynasty S Anhui Provincial Cultural Relics Residential
QJo1 Shu Xiaofei Residence Good Qing Dynasty Vilglage Protection Unit (Pingshan Ancient | Guesthouse
QTO1 Yougqing Hall Excellent Qing (Daoguang) Buildings) Tourism
QT09 Shu Family Residence Good Qing Dynasty Residential
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(Continued)
Conservation . .
Code Courtyard Name Era Village Protection Level Current Use
Status
Former Residence of Cheng . Yixian County Cultural Relics Pro- . .
QJ19 Excellent Qing Dynasty . . Residential
Mengxu tection Unit
) ) Yixian Registered Immovable Cul- . .
QJ20 Residence 1 Excellent Qing Dynasty . Residential
- tural Relics
Yixian
. . Ancient Yixian County Cultural Relics Pro-
HJ06 Residence 2 Good Qing Dynasty X . . Vacant
City tection Unit
QY04 Residence 3 Good Qing Dynasty Yixian Historical Architecture Residential
. . Yixian County Cultural Relics Pro- . .
QJ21 Residence 4 Excellent Qing Dynasty . ) Residential
tection Unit
HJO0S5 Residence NO. 1 Good Qing Dynasty Residential
HTO5 ResidenceNO. 2 Excellent Qing Dynasty Shiting 2nd Batch of Traditional Chinese | Residential
Q22 ResidenceNO. 3 Excellent Qing Dynasty Village Villages List Residential
QJ23 ResidenceNO. 4 Good Qing Dynasty Residential
Former Residence of Huang Bin- . . o
HY03 Excellent Qing (Kangxi) Exhibition
hong (Back) Tandu Anhui Provincial Cultural Relics
Former Residence of Huang Bin- . ) Village Protection Unit o
QTO07 Excellent Qing (Kangxi) Exhibition
hong (Front)
QJo6 Shensi Hall Excellent Qing (Kangxi) Residential
QT02 Xiyuan Garden Good Qing (Qianlong) Nanping National Key Cultural Relics Pro- Residential
vill tection Unit ( Nanping Ancient
. . illage . .
QY03 Jishan Hall (Front Yard) Excellent Qing (Guangxu) g Buildings) Residential
HTO03 Jishan Hall (Back Yard) Excellent Qing (Guangxu) Residential
. Shexian County Cultural Relics .
HTO1 Guotanghang Good Qing Dynasty . . Tourism
Protection Unit
) . . Shexian County Cultural Relics o
QJog Yizhen Hall Excellent Republic of China Yuliang . . Residential
Protection Unit
Village
CTO1 Former Residence of Ba Weizu Excellent Ming (Wanli) Exhibition
Anhui Provincial Cultural Relics
Garden of Former Residence of Ba . . . . o
CY02 ) Excellent Ming (Wanli) Protection Unit Exhibition
Weizu
HYO01 Luo Xinpu Residence Good Qing Dynasty Residential
. . Guanlu . .
QY02 Chunmanyuan (Front Yard) Excellent Qing (Qianlong) Vill Residential
illage
. . Anhui Provincial Cultural Relics . .
HY02 Chunmanyuan (Back Yard) Excellent Qing (Qianlong) . . Residential
Protection Unit
. . . . Tunxi National Key Cultural Relics Pro- o
HJO1 Former Residence of Cheng Dawei | Excellent Ming (Hongzhi) L . . Exhibition
District tection Unit
) . . Liyang Old | Huangshan Municipal Cultural Rel- .
HTO04 Shi Residence Excellent Late Qing . . . Exhibition
Street ics Protection Unit
Former Residence of Wang Renzhi . Shexian County Cultural Relics o
HJ02 Good Early Qing Shexian . . Exhibition
(Back) Protection Unit
Ancient
Former Residence of Wang Renzhi . . Shexian County Cultural Relics .
QJ09 Good Early Qing City Exhibition

(Front)

Protection Unit
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Figure 2 Extraction of courtyard space elements

2 Quantitative analysis of courtyard space form

2.1 Principles of courtyard space quantification

Quantitative indicators related to the size and mor-
phological proportions of courtyard spaces were estab-
lished to describe the courtyard spaces of traditional resi-
dences. The study analyzes five dimensions: courtyard are-
a, area ratio, aspect ratio, saturation, and boundary coeffi-
cient, aiming to grasp the morphological characteristics of
Huizhou traditional residential spaces, such as size and
proportion, from a quantitative perspective.

The dimensions of the courtyard and main building
were obtained through on-site measurement (Figure 3).
The area of the courtyard and the ratio of the courtyard
space to the building footprint were calculated toassess the

scale, size and proportional relationship of the courtyard

space to the main building. In graphic morphology re-
search, the ratio of the projected area of a graphic to the
area of its circumscribed rectangle is often used to define
the degree to which it fills the circumscribed rectangle
[16]. The study uses the ratio of the area of the courtyard
to the area of the circumscribed rectangle as the saturation
degree. The higher the value, the more saturated the court-
yard space is. In order to supplement the saturation degree
in reflecting the indentation and inclination of the court-
yard outline, the ratio of the perimeter of the courtyard to
the perimeter of the circumscribed rectangle is used as the
boundary coefficient. The closer the value is to 1, the more
regular the courtyard outline is. The aspect ratio of the cir-
cumscribed rectangle is used as the aspect ratio of the

courtyard space.
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Figure 3 Quantitative description of the sample courtyard
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2.2 Quantification of the morphological characteristics of

courtyard spaces

By conducting statistical analysis on five aspects of the

sample courtyards—area, area ratio, aspect ratio, saturation, and
boundary coefficient—the general rules of the courtyard spatial

arrangement can be grasped as a whole (Figure 4).
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Figure 4 Analysis of the quantitative coefficients of the courtyard

In terms of area, the average area of the sample
courtyards is 78.2 m’, and most of them are under 100 m>.
Courtyards within 50 m* account for 42.9% of the sample
courtyards, and courtyards between 50 m* and 100 m’ ac-
count for 30.2% . It can be seen that, as a supplement to
the main building, the courtyard space is generally smaller
in scale, and its spatial scale is intimate and human-scaled.
There are also some large courtyard spaces. These court-
yards have a weaker sense of enclosure, are closer to na-
ture, and can serve as places for viewing, rest, and daily
life, enriching the lifestyle of the homeowners. In terms of
area ratio, Huizhou traditional residences vary in size, and
the constraints on courtyard construction are different,
thus showing considerable variation. The average area ra-
tio of courtyard space was 0.26, with 73% of the sample
courtyards having an area ratio between 0.1 and 0.4. A-
mong these, the ratio between 0.2 and 0.3 accounted for
the largest proportion (31.7% ).

A percentage higher than 0.4% or lower than 0.1% is
less common. The analysis shows that, in courtyard con-
struction, designers not only made use of limited residual
spaces but also deliberately reserved moderately sized
courtyards that are proportionate to the main building,
thereby enriching the rhythm of the spatial sequence.
However, outside of this general pattern, the survey found
a small number of samples with a small building footprint
but a large courtyard area, or a large building footprint but
a small courtyard space. For these types of courtyards, it is

necessary to consider the special land use conditions and

the living background of the homeowner.

In terms of aspect ratio, the average aspect ratio of
the sample courtyards is 2, and most of them are between
1 and 2, accounting for 68.3% of the sample courtyards.
Those with an aspect ratio greater than 2 are relatively
few. The results indicate that rectangular courtyard spaces
ensure a strong sense of centrality and provide relatively
uniform viewing distances for resting and strolling, con-
tributing to a stable and comfortable spatial perception.

In terms of saturation, the mean value is 0.9, and
65.1% of the sample courtyards are concentrated between
0.9 and 1. It can be observed that, influenced by the tradi-
tional construction concepts of regularity and stability, and
by introducing the regular order of traditional architectural
space into the courtyard, most courtyard spaces areregular
and full. From the perspective of the boundary coefficient,
courtyards with a value less than 1 account for 52.4% of
the sample courtyards, of which 49.2% are in the range of
0.9 to 1. The findings suggest that most courtyards adopted
inclined or bent boundary treatments to adapt to land-use
constraints during construction, although these adjust-

ments were generally controlled within a limited range.

3 Courtyard feature analysis based on clustering analysis

3.1 Classification and analysis of courtyard forms

Clustering analysis, as a multivariate statistical
method, splits or aggregates data according to the data
connection rules to find natural groups in the dataset

[ 17]. The distance between any two points within the

http: / www.viserdata.com/journal/jsa
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same group is less than the distance between any two
points in different groups; data within a group are simi-
lar, while data in different groups are dissimilar. The
study provides a quantitative description of the court-
yard space of Huizhou traditional residences from five
dimensions: area, area ratio, aspect ratio, saturation, and
boundary coefficient. In the clustering analysis, the

quantification coefficients of the selected 63 Huizhou

traditional residential courtyard samples were first
standardized using a standard deviation of 1 to eliminate
the influence of different units of measurement. Subse-
quently, Ward’ s method was employed for cluster anal-
ysis. The classification was determined by observing the
clustering results, and the types were named according
to the distribution characteristics of the initial variables

within each classification result (Figure 5).
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The courtyard spaces of traditional Huizhou resi-
dences can be broadly categorized into four types:

Typel, represented by Ruiyu Courtyard in Xidi and
Taoyuan Residence in Hongcun, has the highest average sat-
uration (0.99) and a relatively low average area (43.25 m®) a-
mong the four types, and is therefore named “medium-
scale square” courtyards. This type of courtyard appeared
most frequently in the sample, accounting for 42.9% of
the courtyards.

Type2, represented by Tongde Hall in Pingshan and
Xiyuan Garden in Xidi, has the highest average aspect ra-
tio (5.23) and a relatively low average area (69.78 m*) a-
mong the four types, and is therefore named “medium-
scale strip” courtyards. This type of courtyard appeared
least frequently in the sample, accounting for 9.5% of the
courtyards.

Type3, represented by the side yard of Xidi Linxi
Villa and Songhetang in Hongcun, have the lowest average
saturation (0.77), average boundary coefficient (0.95), and
relatively low average area (78.15 m’) among the four
types of courtyards. Therefore, they are named “medium-
scale irregular” courtyards, accounting for 31.7% of the
sample.

Type4, represented by the former residence of Wang
Daxie in Hongcun and Shexian Folk House 2, have the
highest average area (177.98 m?), average area ratio (0.39),
and average boundary coefficient (1.01) among the four
types of courtyards. Therefore, they are named “large-
scale complex” courtyards, which are less common in the
sample, accounting for 15.9% .

Courtyard design in Huizhou traditional residences
demonstrates an emphasis on human-scaled spaces and the
use of regularity to enhance spatial order. Due to land con-
straints, many irregular courtyard spaces have emerged. By
cleverly utilizing these spaces and seeking variations with-
in the balanced and symmetrical form of traditional resi-
dences, these spaces often become focal points of the liv-
ing environment. Large-scale complex courtyards often
have high requirements for land conditions. In addition to

organizing circulation, they can also serve as places for

viewing and relaxation, providing a place for homeowners
to enjoy the natural scenery. Medium-scale strip court-
yards generally serve to organize and connect circulation,
but because their narrow and long spaces can easily create

a sense of insecurity, they are generally less common.

3.2 Correlation analysis between morphological type and

location

In Huizhou traditional residences, courtyard spaces
are generally divided into front yards, back yards, and side
yards according to their relative position and orientation to
the main hall. The front yards appeared most frequently,
accounting for 58.7% of the sample courtyards, followed
by the back yards, accounting for 22.2% , while the side
yards appeared the least frequently, accounting for 15.9% .
As the starting point and transition of the architectural
spatial sequence, the front yard is the focus of courtyard
space creation. The axial relationship of the main building
extends to the courtyard space, playing a role in highlight-
ing the family status and symbolizing lineage. In addition,
the front yard can block wind and sand, welcome sunlight,
form a comfortable climate, and satisfy the feng shui pur-
suit of “gathering wind and accumulating qi” [ 18]. Be-
cause the back yard is located at the end of the building’s
flow, it is a more private space and serves less as a circu-
lation area and more as a space for rest and daily life.
There are two common types of side yards. One type in-
volves creating a landscape design for the empty space
within the site, transforming it into a scenic courtyard. An-
other type is arranged on one side of the main building,
and these courtyards serve both as scenic attractions and
circulation hubs.

In terms of the location distribution of courtyards in
the four categories, the front yard is the most common in
medium-scale square courtyards, followed by the back
yard, while the side yard is less common. Among these,
the front yard had the largest distribution in this type of
yard, accounting for 51.4% of the total front yards sam-
pled. In the medium-scale strip courtyard samples, the
front yard was the most common, followed by the side

yard, and no back yards were found. Among the samples
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of medium-scale irregular courtyards, the front yard ap-
peared the most, followed by the side yard, and the back
yard appeared the least. Specifically, the distribution of side
yards in this category accounts for 41.7% of the total side yard
sample, which is the highest proportion for side yards across all
categories and exceeds the proportional representation of front
and back yards within this category relative to their respective
total samples. In large-scale complex courtyards, the back yard
appears most frequently, followed by the side yard, and the
front yard appears least frequently. These types of courtyards
are mostly residential courtyards with relatively simple space
requirements, resulting in complex boundary forms. Therefore,
they are mainly distinguished from the other three categories
by area metrics.

The analysis reveals that medium-scale square court-
yards are predominantly used as introductory spaces, sup-
plementing the outdoor area in front of the main building.
Their human-scaled spatial dimensions and square spatial
layout provide an opportunity to appreciate and get close
to nature, while also providing a comfortable spatial expe-
rience. Medium-scale strip courtyards, due to their long
and narrow spatial characteristics, often express direction-
ality and give the courtyard space a sense of dynamism.
They are suitable for use as front yard spaces in larger res-
idential complexes for circulation organization. Due to the
strict land use conditions in Huizhou, side yards are often
located at the corners of the land. Compared with court-
yards in other locations, they are more affected by the ter-
rain and present a low-saturation form. This unsaturated
spatial form breaks the rigidity of the architectural compo-
sition, making the overall space more dynamic and lively.
Due to the private spatial attributes of the back yard and
its functions of viewing, resting, and living, the space re-
quirements are relatively large, which is more in line with
the concept of “emulating heaven and earth, and imitating
the four seasons”. However, under the condition of tight
land use, it is not easy to create such a large-scale complex
courtyard in the front yard.

3.3 Correlation Analysis between morphological types and

environmental Factors

From the overall distribution of elements, greenery

http: / www.viserdata.com/journal/jsa

elements appeared most frequently in the sample court-
yards. The creation of courtyard spaces emphasizes the
concepts of “learning from nature” and “harmony between
man and nature”. Through the observation of natural scen-
ery and phenomena in the courtyard, people can feel the
vitality of all things, think about the connection between
life and nature, and express their moral ideals and life pur-
suits through images such as “serene bamboo” and “or-
chid in an empty valley”. In addition, in a space rich in
natural elements, people’ s attention is easily diverted,
which can foster positive emotions [ 19]. Thus, the court-
yard space can also play a role in mutual nourishment be-
tween people and nature. As the main source of drinking
water for villagers, wells are mostly located in the village
center or nearby streets and alleys combined with open
spaces, so they rarely appear in the courtyards of residen-
tial houses [ 20]. The distribution and combination pat-
terns of elements differ in the four types of courtyards.
The proportion of each type of courtyard containing vari-
ous environmental elements is used as the distribution ra-
tio of the elements to express the distribution of elements
in each type of courtyard (Figure 6).

Among medium-scale square courtyards, those with
water features, structures, or wells accounted for 37%,
40.7%, and 3.7% of the sample, respectively, which is a
relatively low proportion. These results indicate that medi-
um-scale square courtyards, due to their relatively limited
spatial scale, show less need for additional structures to
reinforce territorial definition or enrich spatial layering
and enclosure. In fact, they may even exacerbate the feel-
ing of crampedness in the courtyard space. In addition,
these courtyards have fewer living functions and are most-
ly front yards that serve more functions of circulation or-
ganization and display. As a result, elements of water wells
and water features are less common.

In medium-scale strip courtyards, those with struc-
tures, stone tables, arches, plaques, or secondary contours
accounted for 83.3%, 50%, 83.3%, 50%, and 50% of the

sample, respectively, which is a relatively high proportion.
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Because the narrow and long space of medium-scale strip
courtyards can easily create a sense of oppression and in-
security, it is necessary to introduce arches and structural
elements to increase their spatial layering. Since these
courtyards often connect several building entrances, the
secondary contour additions that are often arranged at the
building entrance and the wall facing the entrance are also
more numerous. Among them, elements such as lanterns
and couplets are in line with the traditional style and can
effectively enhance the courtyard landscape. However,
some modern signs have caused interference to the court-
yard space due to the confusion in their design [21]. In
addition, courtyards with greenery or stone benches ac-
counted for 50% and 33.3% of the courtyard sample, re-
spectively, which is a relatively low proportion, and water
features were not found in them. The results show that me-
dium-scale strip courtyards, characterized by strong direc-
tionality and spatial dynamism, primarily serve circulation
functions; consequently, elements intended for viewing or
resting appear less frequently.

Among medium-scale irregular courtyards, those with
greenery, water features, or openwork windows accounted
for 90% , 40%, and 55% of the sample courtyards, respec-
tively, which is a relatively high proportion. Courtyards
with stone tables accounted for 25% of the sample court-
yards, which is a relatively low proportion. It can be seen
that when designing medium-scale irregular courtyards,
the irregular spaces are often arranged in a rich way, with
greenery and water features used to mask and remedy the
irregular parts of the courtyard, thereby weakening the ir-
regular shape of the space. Furthermore, using the court-
yard wall as the “ground” and the openwork window as
the “figure”, the openwork window becomes a visual focal
point of the courtyard space, which can effectively reduce
the feeling of irregularity of the courtyard space under the
“spotlight effect” [ 22]. Simultaneously, in the Huizhou
region, where literature and art flourish, these elements
possess rich artistic value and scholarly aesthetic, enhan-

cing the spatial level recognition. Stone tables are often

placed in courtyards in conjunction with building en-
trances to follow or support the building axis. However, in
medium-scale irregular courtyards, the alignment with the
building axis is weaker, so the placement of stone tables is
correspondingly less frequent.

In large-scale complex courtyards, those with water
features or stone benches accounted for a relatively high
proportion of 40% and 60% of the sample, respectively.
These findings suggest that this type of courtyard is gen-
erally more open and closely connected to nature, functio-
ning primarily as a space for viewing and rest. The ar-
rangement of more water features, stone benches, and oth-
er rest elements enriches the spatial layers and circulation
paths of the courtyard. Based on the concepts of “a resi-
dence with water possesses spirit” and “accumulating wa-
ter gathers wealth”, and given that the courtyard is large
enough to accommodate water features, these courtyards
often incorporate water features to serve purposes such as
fire prevention, cooling, and irrigation. At the same time,
the leisurely swimming fish in the water express the desire
for a free and unrestrained life, roaming between heaven
and earth. In addition, courtyards with openwork windows
or arches accounted for 20% and 10% of the sample
courtyards, respectively, which is a relatively low percent-
age. The results indicate that these courtyards place greater
emphasis on creating a peaceful and comfortable living at-
mosphere and, due to their private and introverted spatial
attributes, rarely establish visual connections with the ex-
ternal environment through arches or openwork windows.

Overall, the analysis reveals that the arrangement of
spatial elements varies significantly among courtyard
spaces with different morphological characteristics. The
arrangement and combination of these elements either en-
hance the spatial characteristics or mitigate shortcomings.
Medium-scale square and irregular courtyards have a high
degree of element richness. Among them, medium-scale
square courtyards have more elements such as greenery,
water features, stone tables, and stone benches. Medium-

scale irregular courtyards are mainly characterized by
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greenery, water features, and openwork windows. Medium-
scale strip courtyards and large-scale complex courtyards
have a low degree of element richness. Medium-scale strip

courtyards are mainly composed of structures, arches,

plaques, stone tables, and secondary contours, with fewer
planar elements. Large-scale complex courtyards are main-
ly composed of greenery, water features, and stone bench-

es, with fewer vertical elements.
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Figure 7 Statistics and comparison of element combinations

3.4 Correlation analysis between elements

The combination patterns of elements in courtyards
are complex and exhibit strong individual characteristics.
By statistically analyzing the distribution of element com-
binations in various types of courtyards, the correlation
between elements is analyzed (Figure 7), thus providing a
reference for the combination of elements in residential
courtyards. The proportion of courtyards with various
combinations of elements in a given category of court-
yards is used as the frequency of occurrence of element

combination patterns to express the degree of correlation
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between elements in each category of courtyards. If the
frequency is below 0.2, the correlation between the ele-
ments is considered low; if the frequency is between 0.2
and 0.4, the correlation is considered moderate; and if the
frequency is above 0.4, the correlation between the ele-
ments is considered high. Overall, the greening elements
are highly correlated with elements such as water features,
stone benches, structures, or openwork windows, indica-
ting that while introducing natural landscapes, the embel-
lishment of artificial elements is more conducive to crea-

ting a spatially permeable, comfortable, and leisurely
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courtyard space. Looking at the combination distribution
in various types of courtyards, they are mostly arranged a-
round the main constituent elements. The combination pat-
terns are most abundant in medium-scale square court-
yards and medium-scale irregular courtyards, followed by
medium-scale strip courtyards, while the combination of
elements is less abundant in large-scale complex court-
yards.

In medium-scale square courtyards, the “greenery-
bench” element combination had the highest frequency of
0.41, indicating the highest correlation. Meanwhile, the
frequencies of combination patterns such as *“ water-
bench”, “bench-door”, and “bench-contour” are 0.33, 0.22,
and 0.22, respectively, which are more frequent than in
other types of courtyards, reflecting that the correlation
between elements such as water features, arches, secondary
contours, and stone benches is relatively higher in this
type of courtyard. Combining and arranging these ele-
ments can serve to connect the axis, enrich the landscape
layers, and optimize the rest space within a relatively
small and regular space.

In medium-scale strip courtyards, the common com-
bination patterns are mainly “greenery-structure”, “door-
table”, “door-structure”, “door-window”, “plaque-table”,
“plaque-structure”, and “plaque-door”, with frequencies
of 0.5, 0.5, 0.67, 0.5, 0.5, 0.5, and 0.5, respectively. These
patterns appear more frequently than in other types of
courtyards, indicating a high degree of correlation between
elements such as greenery, plaques, stone tables, openwork
windows, arches, and structures. The arrangement of these
elements, while increasing spatial layers and reducing the
sense of depth, ensures that every section of the courtyard
is appropriately sized and exudes an elegant atmosphere.

In medium-scale irregular courtyards, the combina-

1

tion patterns of “ green-structure”, “ green-window ”,

3 &

“green-door”, “ water-structure”, “ water-window”, and
“structure-window” appear relatively frequently, with fre-
quencies of 0.55, 0.4, 0.4, 0.3, 0.3, and 0.4, respectively. At
the same time, these combination patterns are relatively

more common in other courtyards, reflecting the high cor-

relation between elements such as greenery, water features,
structures, and openwork windows. It can be seen that
while individual elements can cover and repair irregular
spaces, combining these elements can strengthen the re-
duction of spatial irregularity, enhance the spatial quality,
and transform the courtyard into a highlight of the archi-
tectural space.

For large-scale complex courtyards, common combi-
nation patterns are mainly “green-water”, “green-bench”,
“green-structure”, and “table-bench”. These combination
patterns have a combination frequency of 0.4, 0.5, 0.4, and
0.3, which is higher than that of other types of courtyards.
In these types of courtyards, elements such as water fea-
tures and stone benches are often combined with greenery
to create a space that feels close to nature, while providing

a richer environment for relaxation.
Conclusions

By introducing spatial quantitative indicators to de-
scribe the spatial form of courtyards, and summarizing the
location characteristics and element distribution patterns
of courtyard spatial types based on clustering analysis
(Figure 8), the study found that:

(1) Overall, the courtyard area of Huizhou traditional
residences is mostly within 100 m’. with a suitable spatial
scale, which is suitable for construction under the tight
land use conditions in Huizhou; the courtyard area is
mostly 10% to 40% of the building area, which is in ap-
propriate proportion to the main building and serves as an
outdoor supplement to the main building; the aspect ratio
can be divided into two categories: between 1 and 2 and
greater than 2. The aspect ratios of most of them are be-
tween 1 and 2, reflecting traditional design principles em-
phasizing regularity and stability. Their regular spatial
form can give people a comfortable and stable spatial ex-
perience. For courtyards with an aspect ratio greater than
2, the space often exhibits a strong sense of dynamism and
has more circulation attributes. Regarding the distribution
of location, front yards are the most common, followed by

backyards, with side yards being the least common. As the
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starting point of the architectural sequence, the front yard
is often the focus of courtyard design. In terms of element
arrangement, greenery elements are the most numerous o-
verall, with structures, water features, openwork windows,
and arches also appearing frequently. In terms of element
combination, greenery elements are often combined with
water features, stone benches, structures, and openwork
windows. While introducing natural landscape imagery,
this arrangement expresses the ideals of the literati, and
the rich elements embellish and enhance the spatial atmos-
phere that combines the artificial and the natural.

(2) Medium-scale square courtyards are the most
common, reflecting that even under the tight land use con-
ditions in Huizhou, there is an enduring priority placed on
the creation of courtyard space. The square and stable spa-
tial order is well reflected in the courtyard space, and the

form and proportion are consistent with the main body.

These types of courtyards are mostly located in the front
yard and back yard. As important circulation organization
spaces and extensions of living spaces, the front and back
yards require square and comfortable spaces. Therefore,
when conditions permit, building medium-scale square
courtyards is more conducive to maintaining consistency
with the main form and to functional use. In terms of spa-
tial configuration, small and medium-scale square court-
yards often combine elements such as stone benches with
greenery, water features, arches, and secondary contours to
extend spatial functions, enrich landscape layers, and en-
hance spatial interest. Therefore, when creating courtyard
spaces for residential buildings, the primary consideration
should be to create a courtyard with a square shape and
moderate size, and to embellish and enhance it with spatial
elements, thereby forming a comfortable and pleasant

courtyard space that extends the building space outdoors.
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. Spatial transition P . . .
Medium-scale ! : Wi o Maintain the historical landscape pattern of Huizhou
square outdoor Front>back>side | Green>Bench>Structure=Window>Door=Water>Table>Secondary>Plaque>Well traditional residential courtyard spaces
supplement
Circulation Guide the spatial sequence b i
T ) y creating a sense of
Med':tTi scale I%:%aen;;:%oemtfi: Front>side>back | Structure=Door>Green=Table=Window=Plaq y>Bench>Well>Water | directionality in the courtyard, and mitigate the
P complexes uncomfortable spatial feeling through element arrangement
) Sightseein Rationally utilize different terrains to create courtyards,
Medium-scale ghtseeing, Side>front>back | Green>Structure>Window>Bench>Water=Door>Secondary>Table>Plaque>Well | and weaken the sense of spatial irregularity through element
irregular circulation arrangement
Large-scale Daily living, . >Bench> >Water>Table>Wi >Well=Door= >P| Construct larger-scale courtyards where conditions permit,
complex close to nature Back>front>side | Green>Bench>Structure>Water>Table>Window>Well=Door=Secondary>Plaque to better get close to and dwell in nature

Legend: Green: Greenery Water: Water feature Table: Stone table bench: Stone bench structure: Structures Well: Water well Window: Openwork window Door: Arch Plaque: Word plaque Secondary: Secondary contour

Figure 8 Summary of the regular characteristics of courtyards

(3) Medium-scale strip courtyards are mainly front
yards. As the circulation space at the front of the building,
the front yard requires convenient circulation access. Be-
cause of the spatial dynamism and directionality embodied
by the strip courtyard, it is often used as the front yard for
circulation organization in larger residential complexes. In
terms of element configuration, the main elements are
structures and arches, which are combined with greenery,
plaques, stone tables, and openwork windows to reduce the
sense of oppression and insecurity caused by the narrow
space. Therefore, when faced with a long and narrow
courtyard space due to land constraints, the sense of con-

striction can be reduced by using structures, arches, and
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other elements to divide and add layers.

(4) Medium-scale irregular courtyards are mainly
front yards and side yards. Under the combined effect of
irregular land conditions and the regular main building
plan, these courtyards present an irregular spatial form. In
addition to being arranged as a viewing space, they also
undertake certain circulation functions. Because it seeks
variation within a regular planar shape,this type becomes a
highlight in the architectural space. In terms of element
configuration, greenery, water features, openwork win-
dows, and their combinations are the most common ele-
ments. The irregularity of the space is reduced by remed-

ying the space and placing a visual center. Therefore, when
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faced with restrictions on land use conditions or irregular
shapes of residential land, the impression of spatial irregu-
larity can be mitigated by using elements to shield or cor-
rect them, or by arranging eye-catching elements to form a
visual center.

(5) Large-scale complex courtyards are mainly back
yards, which are mostly living and resting spaces. If the
land conditions permit, it is more conducive to building a
larger courtyard to create a courtyard space that incorpo-
rates more landscape and pastoral imagery and is close to
nature, so as tofoster relaxation and spiritual tranquility in
a courtyard environment full of natural charm. In terms of
spatial configuration, the layout mainly features natural
leisure elements such as water features and stone benches,
and often combines them with greenery to provide resi-
dents with a comfortable and private living environment.
Therefore, where land conditions permit, a large-scale
courtyard space can be created by combining natural land-
scapes and recreational facilities to satisfy the pursuit of
living in nature.

In conclusion, by studying the spatial organization
patterns of courtyards based on typological analysis, we
can underst and the general rules of different courtyard
spatial arrangements, thus providing a basis for the protec-
tion and restoration of Huizhou traditional residential
courtyard spaces [ 23, 24]. Meanwhile, when constructing
courtyard spaces for new Huizhou-style residences, atten-
tion should be paid to creating regular and square court-
yard spaces that provide human-scaled and outdoor spaces
that are in harmony with the building’s proportions. When
land conditions permit, a large-scale courtyard space can be
built at the rear of the building, and the natural and private
spatial atmosphere can provide a variety of supplements to res-
idential life. The relatively long and narrow courtyard can be
used to guide the spatial sequence, and the spatial comfort can
be increased by dividing the space through structures and ar-
ches. In addition, irregular land use can be used to carry out di-
versified designs, and spatial elements can be inserted to reme-
dy defects or form a visual center to soften the impression of

irregular space [ 25, 26].

Sources of Figures and Tables
All figures and tables in this article were drawn and pho-

tographed by the authors.
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